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INTRODUCTION 

 
This guide details how to program the wire to wireless device (translator), its wireless coverage extenders (expanders) and the system’s child 
devices. Programming is carried out before the translator device (thus the wireless system) is connected to the hard wired control panel. 
 
System coverage can be increased by the using range expander modules; these must be directly powered by suitable EN54-4 compliant 12-
24VDC power supply units. 
 
If the installation requires a large number of devices, it is recommended to program them before deploying to their intended locations. 
It is also recommended to make a complete site survey before starting at all: doing this will help to determine the optimal device’s position 
arrangement. 
 
This guide describes, also, the available auxiliary procedures useful for diagnosing potential problems, assessing their causes and carrying 
out solutions.  
 
Before you start, be sure to have the suitable WirelEx Fire software installed on a portable pc and a RS232 serial connection (9 pin DE-9 type 
connector cable). 
 
WIRELESS DEVICES - GENERAL DESCRIPTION 

 
A wireless fire security system is composed by a combination of the following devices: 
 
WIRE TO WIRELESS TRANSLATOR 

This is the core of a wireless system. 
It communicates continuously with all the other wireless devices. 
On the other hand it communicates with the control panel of the wired intelligent fire security system. 
Summarizing: the translator communicates with the control panel through wire and with all wireless devices through radio. 
 
As any other fire security system, the whole system (hard wired and wireless) is controlled by the control panel; the translator is just the 
interpreter that holds exclusive rights of communication with the wireless devices, thus making possible communication between the control 
panel and the radio devices: this is why this device is called “translator”. 
The wireless system overall configuration, as created by the installer, is stored in this device. 
 
WIRELESS CONVENTIONAL EXPANDER 
Permits to add a wireless system to a conventional control panel; this device is connected directly to the zone line. 
This type of expander silences its wireless sounders after receiving the suitable signal from the conventional panel’s sounder line. 
 
WIRELESS EXPANDERS 
Translators and conventional expanders communicate with other wireless devices only in a certain range or if consistent obstacles are out of 
the way. When wireless area coverage needs to be expanded or the environment poses obstacles to radio communication, it is possible to 
use one or more expanders. 
 
SENSORS 

These devices sense smoke and / or heat in the environment; if heat and / or smoke exceed a certain limit, the wireless system goes in alarm. 
 
SOUNDERS 
These devices emit sound when the wireless fire security system is alarmed in order to alert people in the protected environment that they are 
in danger. Sounders can be combined with inbuilt strobes that add to the acoustic indication a visual one. 
 
BEACONS 
They have a similar function to the sounders with the difference that they emit light and not sound. 
When the fire system is alarmed, the light signal from these devices alert people in the protected environment that they are in danger. 
 
VOICE ANNUNCIATORS 
These devices are actually very similar to sounders: instead of emitting preselected standard tone patterns, voice annunciators emit  
pre-recorded human voice messages. 
 
CALL POINTS 
Call points are used to manually raise an alarm condition in the protected environment. 
 
MODULES 

It could be sometimes necessary to connect the wireless system to other devices that are not designed to communicate with the translator; to 
connect them to the fire security system, a module must be used. 
External devices generally work on an on / off basis. 
First example: an external device is activated, the connected module detects this event and alerts the translator. 
Second example: the wireless system falls in alarm, the module detects this event and activates the external device. 
Module devices are classified as input or output types; the first example above gives an idea of what is an input module; the second example 
above gives an idea of what is an output module. 
 
DOOR HOLDERS 
These devices keep fire doors open. In the event of a fire alarm, the fire doors are released to allow them to shut. 
 
REMOTE INDICATOR LAMPS 

When the system is alarmed, these devices emit a continuous light.  
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WIRELESS SYSTEM - BASIC INFORMATION 

 
The translator is connected to the control panel through the hard 
wired intelligent loop; on the other hand, the translator communi-
cates through radio signals with all wireless devices. 
 
The translator communicates with the wireless child devices 
either directly or indirectly through the expander modules. 
 
The main control panel interacts with the child devices through 
the translator. 
 
When configuring the wireless system, you must program the 
translator and the expanders (if present). 
 
 
Before you position the system components to their locations take into account that: 
 
- there is a maximum number of child devices and expanders that can be linked in a single wireless system, so to its central node:  
 the translator; 
- the communication range of the translator, expanders and all child devices is limited; range shrinks in indoor environments. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you need a number of child devices higher than the maximum num-
ber allowed by a single wireless system, you can connect to the control 
panel more than one translator: all wireless child devices will be parti-
tioned between their “father” translators. 

 
THE RADIO SURVEY KIT 

 
 
 
 
This diagnostic kit allows you to discover the best possible positions for 
child devices in terms of wireless signal’s quality. The kit is composed 
by a wireless detector, an expander, a tablet, a dedicated dongle 
interface device and a pole. 
 
You simply place the kit’s expander in the location where a translator or 
expander is planned to be installed. 
 
Using the kit’s detector, you assess, by sampling the various possible 
locations, the wireless signal’s quality. 
 
Assessment values are visualized on the tablet’s screen. 
 
To assess locations at ceiling level, it is possible to fit the test detector 
at one end of the pole. 

Wireless 

expander 

Test detector 

Supporting 

pole 

Tablet 

Dongle interface 

device 
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It is suggested to keep all wireless devices at least 
2 meters distance from: 
 

- equipment using large amounts of electrical current 
- large metal objects, structures or metal ceiling structures 
- fluorescent lighting fixings 
- computers, their cabling and network cabling 
- the control panel. 



Maximum number of child devices program-
mable in a single wireless system 

32 child devices Child devices do not include the expander modules 

Maximum number of output child devices 
programmable in a single translator, wireless 
conventional expander or expander 

16 output child devices 
Sounders, voice annunciators, output modules, beacons, remote 
indicators, door holders 

Maximum number of expanders programma-
ble in a single wireless system  

7 expanders  

Maximum number of expanders connected 
sequentially one after another 

5 expanders  

Maximum number of expanders connected to 
a single translator, wireless conventional 
expander or another expander 

3 expanders   

SINGLE WIRELESS SYSTEM LIMITATIONS AND STRUCTURAL EXAMPLES 

Level 1 

7 expanders max 
3 expanders per level max 

5 levels max 

Translator Expander Child device 

Level 0 

Level 2 

Level 3 

Level 4 

Level 5 

Level 1 

Level 0 

Level 2 

Level 3 

Level 4 

Level 5 

Level 1 

Level 0 

Level 2 

Level 3 

Level 4 

7 expanders max 
3 expanders per level max 

7 expanders max 

Level 5 
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INSTALLING THE WIRELEX FIRE SOFTWARE 

  
Double click on the WirelEx Fire setup executable file. 

 
 
 
 
 
 
 
Select language that will be used by the installation procedure. 
Click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the destination folder for the software on the PC or leave the 
default setting; to change the folder select Browse... 
Next > for proceeding. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select a “Start Menu” folder where the shortcut links to the WirelEx 
software will be stored. 
With Browse… you can select an existing folder or create a new 
one by editing the text box. 
Next > for proceeding. 
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Check the box Create a desktop shortcut if you want to create a 

shortcut link on the desktop window. 
 
Click Next > to proceed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This window summarizes the choices made before. 
Click Install to start off the installation phase. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Software installation will normally take up a few moments. 
If any problem arises, to eventually stop the installation you can 
click Cancel. 
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On the setup final window you can check the Launch WirelEx Fire 
option: doing so, when you click Finish, you will start immediately 
the execution of the WirelEx software. 

 
If you deselect the Launch WirelEx Fire option and then click 
Finish, you can execute the WirelEx software successively. 
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INITIAL CONFIGURATION 

  
Connect the computer to the translator with a RS232 serial cable. 
 
Start the WirelEx Fire software by double clicking on the WirelEx Fire icon. 

 
 
 
 
 
 
 
 
 
 
Select Options > Settings on the main menu. 
 
A Settings pop-up window will appear. 
 
Select the COM port and Language you are using. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the Settings pop-up you can also: 

 
Open last system on startup  

If checked, loads automatically the last saved system config-
uration file. 
 
Synchronize time with PC 

Translator and expander module’s time is synchronized with 
the time of the computer. 
 
Use small icons 

If checked, the software will use small icons instead of the 
standard ones. 
 
 
All Settings changes will take place only when the WirelEx 
software will be closed and restarted again. 

www.advancedco.com ADVANCED ELECTRONICS LTD - Moorland Way, Nelson Park, Cramlington, Northumberland, 

United Kingdom, NE23 1WE 



LOOKING UP FOR FREE CHANNELS - THE “RFANALYZE” TOOL 

 
The wireless system will work on a radio channel that you must select during configuration; for this reason it is suggested to: 
 
- select a channel that is not used by other wireless systems 
 
or 
 
- select a channel that is not excessively congested. 
 
To assess the degree of congestion of a channel use the RFAnalyze software.  

 
Connect the computer to a powered translator or expander through the serial cable. 

 
 
 
 
 
 
 
 
 
 
 
From WirelEx select the Tools > Radio field analyse 
utility item from the main menu.. 
 
 
 
 
 
 
 
 
 
 
 

The RFAnalyze program will be launched: 
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Click the Options > Settings. The Settings pop-up window will appear: 

 
 
 
 
 
 
 
 
 
 
Select the appropriate COM port (Com Port). 
 
Check if Language and Frequency Band options are 
appropriately selected. 
 
Click Apply to confirm changes, Cancel to discard 

them. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click the Start icon to begin channel congestion scan-

ning. 
 
To stop scanning click the Stop icon. 
 
The graphic lines show the degree of wireless conges-
tion on ALL channels. 
 
A single graphic line and its colour is associated to the 
representation of the wireless traffic congestion on one 
single channel. 
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On the right side of the window, uncheck the boxes 
relating to the channels of which you want to hide the 
congestion graph. 
 
Keep checked just one single box. 
 
By checking a single channel’s congestion graph at a 
time, assess which one is “flatter” or “less disturbed”. 
 
The “flattest” and “less disturbed” channel is the one on 
which is best for your wireless system to work. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can change the time scale of the graphic repre-
sentation by sliding the Data selection period cursor 
located in the bottom area of the screen. 
 
Located in the bottom area of the screen, the Received 
signal level mutually exclusive selection buttons 
allow you to select whether you want to visualize 
congestion in dBm or RSSI units. 
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CREATE A NEW SYSTEM 

  
 
 
 
 
 
 
 
 
 
On the WirelEx window select the File option on the 
main menu. 
 
A drop down menu appears. 
 
Select the New system… option.  

 
 
 
 
 
  
  
  
 
 
 
 
 
 
 
 
 
 
 
The System window will pop-up. 

 
If you need to do so, you can change the System code. 

 
You can select here the wireless Channel. 

 
Apply to confirm, Cancel to discard. 

 
 
 
 
 
 
 
 
 
CHANNEL 

Communications between wireless devices are exchanged through seven distinct radio channels. 
When configuring the wireless system, you must assess which channel is free or less congested and instruct the system to operate on that 
channel. 
The advantage of operating on a free, or relatively free, channel is to have the best communication quality between the wireless devices. 
 
SYSTEM CODE 

A translator and the wireless devices, directly or indirectly connected to it, constitute a single wireless system “cluster”. 
 
If, in a fire security system, there is more than one translator (so more than one wireless “cluster”), it can happen that at least two or more 
wireless systems use the same channel. 
 
Every wireless system has a system code. 
 
Its purpose is to distinguish different wireless systems and to avoid communication conflicts. 
 
It is composed by two numbers. The fist number is by default randomly generated by the WirelEx software during configuration; you can 

modify this number if it is necessary for you to do so. 
The second number is randomly automatically generated by the WirelEx too, but you cannot change it. 
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If it has not been already done, select the System tab. 
 
Right click on the System icon, located in the upper left 
area of the tab page. 
 
A pop-up menu appears. 
 
Select the Add central node option. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Add central node pop-up window appears. 

 
Choose one of the selectable central node type options 
presented in the pop-up window. 
 
Add button to set the desired central node type in 
the new system. 
Cancel to give up. 
 
A wireless system “cluster” can have only one central 
node. 
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Added the central node, a property window will pop-up; let’s assume you have added a translator: 
 
 
 
 
Here you can set the Child expander’s supervision period value. 
 
If the translator does not receive at least a communication from one of its expanders in this 
specified amount of time, “assumes” that the communication with it is lost: a fault condition is 
then signalled to the control panel. 
 
Apply to confirm, Cancel to discard the setting. 
 
 
 
 

 
 
 
 
 
 
A translator icon now appears in the wireless system’s 
topology tree. 
 
Note that the translator’s product code at the right of 
the icon is printed out with a normal non-bold font; this 
means that the translator need programming in order to 
make effective the last change made. 
 
Connect the serial cable (if you have not done so 
before). 
 
Right click on the translator icon. 
 
On the pop-up menu click on the Program menu item. 
  
 
 
 
 
 

 
You can add your comments (like a device location in the site, “Detector #1”...) to the system’s software configuration. 

 
 
 
 
 
 
Right click on the device icon. 
 
On the pop-up menu select the Comment option. 

 
A Comment pop-up will appear; you can type in a 31 

alphanumeric characters maximum comment. 
 
Apply to confirm, Cancel to discard. 

www.advancedco.com ADVANCED ELECTRONICS LTD - Moorland Way, Nelson Park, Cramlington, Northumberland, 

United Kingdom, NE23 1WE 



ADD THE CHILD DEVICES 

 
 
 
 
 
 
 
 
 
 
 
Right click on the translator’s icon. 
 
Select Add child device on the pop-up menu. 

 
 
 
 
 
 
 
 
 
 
 
 

A pop-up window with the list of all child devices will appear: 
  
 
 
 
 
 
 
 
Click on the child device icon required. 
 
Quantity field: set the required numeric quantity of the selected child device. 

 
Click Add to confirm, Cancel to discard.  

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
A window pop-ups, allowing you to set the child de-
vice’s operating parameters. 
 
If in the previous window you specified a Quantity 
greater than one, you will notice that the Address field 
refers to the wireless address of only the first device; 
despite of this, the parameter changes you make in 
this window will be applied to ALL the new child devic-
es. 
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If you intend, successively, to change a child device’s 
operational parameters: 
 
Right click on the child device’s icon. 
 
Select Properties on the pop-up menu. 

 
 
 
 
 
 
 
 
 
 

You need now to program the translator, otherwise the changes you have made will not be effective. 
 
On the system’s topology tree, remember: 
 
20-VW2W100-ADV (normal font) = NOT programmed 
20-VW2W100-ADV (bold font) = programmed. 

 
This applies to ALL central nodes and expanders. 
 
If you want to see the child devices assigned to a central node or an expander, click on its icon on the system’s topology tree; its child devices 
will be shown in a row-column list at the right of the screen. 
 
The graphic indication in the Programmed column in the child devices list can be: 

 
 
 
 
 
 
 
 
 

Child devices linking (and programming) will be explained later. 
 
 

 = Chid device linked (programmed) 

 = Child device not linked (not programmed) 

 = Child device linked but in need of update (explained later) 

 
 
 

The wireless system will work properly only if: 
 
- All central nodes and expanders are programmed 
 
- All child devices are linked (programmed). 
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ACCESSING AND CHANGING CHILD DEVICES’ PROPERTIES  

 
On the child device’s list, right click on the line you are interested in. 
  
A pop-up menus appears. 
 
Click on the Properties menu option. 

 
Change the desired properties. 
 
Program the child device with the link procedure explained later; if you omit to do so, your changes will not be effective on the real system.  
 
CHILD DEVICES’ COMMON WIRELESS SETTINGS  

 
Child devices have all in common those three parameters: 
 

  
 
 
 
 
 
 
20-SG100-AVD / AXIS-ROP 
OPTICAL DETECTOR 

 
The desired smoke sensitivity level can be selected 
with the Sensitivity drop down list. 
 
LED indications for fire and battery discharge events 
can be disabled unchecking the Fire and Battery 
Discharge checkboxes. 
 
Apply to confirm, Cancel to discard. 
 
 
 
 
 
 
 
 
 
 
 
 
20-SG200-ADV / AXIS-ROH 
MULTI-CRITERIA DETECTOR 
 
The desired smoke sensitivity level and thermal class 
can be selected with the Sensitivity and Type drop 

down lists. 
 
You can disable the smoke alarm criteria or the thermal 
alarm criteria by unchecking the Process (Smoke 
channel) checkbox or the Process (Thermo chan-
nel) checkbox; you cannot uncheck both boxes. 

 
LED indications for fire and battery discharge events 
can be disabled unchecking the Fire and Battery 
Discharge checkboxes. 

 
Apply to confirm, Cancel to discard. 

 

General Address wireless address; assigned by the software automatically; you cannot change it. 

Parent expander’s 
check-up period 

indicates how often the child device reports its data to his father translator or 
expander. 
Battery life and wireless traffic strongly depend on this parameter; do not change it 
from its default setting if it is not really necessary. 

Supervision period 
if the chid device does not report its data in this period of time, the father translator 
or expander will signal a fault (“no link” fault). 
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20-SG350-ADV / AXIS-RHT 
THERMAL DETECTOR 

 
The desired thermal class can be selected with the 
Type drop down list. 
 
LED indications for fire and battery discharge events 
can be disabled unchecking the Fire and Battery 
Discharge checkboxes. 
 
Apply to confirm, Cancel to discard. 
 
 
 
 
 
 
 
 
 
 
 
20-SGCP100-ADV 
RESETTABLE CALL POINT 

 
LED indication for battery discharge events can be 
disabled by unchecking the Battery discharge check-
box. 
 
You can disable the tamper spring sensor by checking 
the Do not supervise Tamper check box. 
 
Apply to confirm, Cancel to discard. 
 
 
 
 
 
 
 
20-SGMI200-ADV 
INPUT MODULE 

 
LED indications for battery discharge events can be 
disabled by unchecking the Battery discharge check-
box. 
 
You can disable the tamper spring sensor by checking 
the Do not supervise tamper circuit check box. 
 
Apply to confirm, Cancel to discard. 
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20-SGMCB200-ADV / 20-SGFI200-S-ADV 
BATTERY OUTPUT MODULE 
 
You use this window to set the properties of more than 
one device type. 
 
If configuring the 20-SGMCB200-ADV, LED indica-

tions for battery discharge events can be disabled by 
unchecking the Battery discharge checkbox. 

 
You can select the action type performed by the acti-
vated relay output through the Relay Type drop down 
list. 
 
You can activate the 12/24VDC output by checking the 
Activate Output box, then selecting its Voltage 
characteristic profile; through the Control the integrity of 
connection check box you can enable the supervi-
sion of the 12/24 VDC output. 
 
 
 
 

By checking the Do not supervise input box, you instruct the module to ignore tamper and FLT faults. 
 
If you are configuring the 20-SGFI200-S-ADV and SGDH100 devices, only the General (common to all devices) and the Battery Dis-
charge options will be effective. 

 
Apply to confirm, Cancel to discard. 

 
 
 
 
 
 
 
 
AXIS-RWSM+AXIS-CWS / 20-SGR(B)S100-ADV 
SOUNDER 

 
LED indication for battery discharge events can be 
disabled unchecking the Battery Discharge checkbox-
es. 
 
You can disable the tamper spring sensor by checking 
the Do not supervise tamper circuit check box. 
 
Apply to confirm, Cancel to discard. 
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20-SGBE100-ADV 
BEACON 

 
LED indications for battery discharge events can be 
disabled by unchecking the Battery discharge check-
box. 
 
You can disable the tamper spring sensor by checking 
the Do not supervise tamper circuit check box. 
 
Apply to confirm, Cancel to discard. 
 
 
 
 
 
 
 
20-SGMC200-ADV 
OUTPUT MODULE 

 
Low Power Supply 

Uncheck this box to disable LED indication when the 
module’s supply voltage falls under the minimum level. 
 
External Fault 

Check this box to enable LED indication in the event of 
a fault detection on the FLT input. 
 
Do not use front tamper 

Check this box to disable the tamper spring sensor. 
 
Do not supervise supply voltage 
Check this box to disable the supervision of the mod-
ule’s supply voltage. 
 
Do not supervise external fault input 
Uncheck this box to enable the supervision of faults on 
the FLT input. 
 
 

Relay Type 

You can select the action type performed by the activated relay output through this drop down list. 
 
 
20-SGVA200-ADV 
LOUDSPEAKER 
 
LED indication for battery discharge events can be 
disabled by unchecking the Battery Discharge check  

box. 
 
You can disable the wall tamper spring sensor by 
checking the Do not supervise wall tamper detector 

check box. 
 
Loudspeaker’s output signal is set to maximum power 
by default; you can attenuate it up to –9 dB by sliding 
the Attenuation of output signal power cursor. 
 
The alert double tone signal preceding the alarm voice 
message can be disabled by checking the Do not 
reproduce double-tone signal before sounding 
box. 
 
Reproduce signal from aux input “GO/CHS” and 
Preamplification of signal “GO/CHS” options are 
not used. 
 
Apply to confirm, Cancel to discard. 
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ADD THE EXPANDER DEVICES 

 
 
 
 
 
 
 
 
 
Right click on the translator icon. 
 
A pop-up menu appears. 
 
Select the Add expander device menu option. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Add expander device window appears. 

 
Select the device Quantity you require for the installa-

tion. 
 
Press Add. 
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An expander property window appears. 
 
If in the previous window you have selected a Quantity of expanders to add greater than 
one, you will notice that the Address field of this properties window indicates the wireless 
address of the first expander; despite of this, the properties you set here will be applied to 
ALL expanders you add to the wireless system. 
 
Remember that you can visualize again this window for a single expander by right clicking on 
the required expander icon. 
 
Parent expander’s checkup period 

This drop down list indicates how often this expander reports its status to the “father” transla-
tor or expander. 
Wireless traffic strongly depend on this parameter; do not change it from its default setting if 
it is not really necessary. 
 
Chid expander’s supervision period 

If the “father” translator or expander device does not receive a status report from this ex-
pander in this specified period of time, the “father” device signals a “no link” fault. 
 
 
 
 
 
 

Main PS control 
Uncheck this box to disable the main power supply supervision; if you disable this and if the power supply voltage falls under the specified 
minimum level, this expander will signal a fault. 
 
Standby PS control 
Uncheck this box to disable backup power supply supervision; if you disable this and if the power supply voltage falls under the specified 
minimum level, this expander will signal a fault. 

 
 
 
 
 
 
 
 
 
 
 
The procedure for adding and managing the child 
devices that are assigned to an expander is identical to 
the one that is used for the translator module; the only 
difference is that it is applied to the specific expander 
icon and not to the translator icon. 
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PROGRAM THE SYSTEM 

 
Configuration is now complete, at least on the comput-
er. 
 
Now the configuration need to be programmed on the 
wireless system. 
 
If you are deploying a brand new installation: 
 
Right click on the translator icon. 
 
Contextual pop-up menu appears. 
 
Click the Restore 20-VW2W100-ADV to factory 
setting (clear) menu option. 
 
 

 
 
 
 
 
 
 
 
 
 
A pop-up window will show the translator’s old system 
code. 
 
Click Yes to continue; No to give up. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You will be asked for a confirmation of this operation. 
 
Click Yes to continue; No to give up. 

If you execute Restore 20-VW2W100-ADV to 
factory setting (clear) and you have in the 
configured system child devices that have 
been already linked and programmed, you 

must successively relink and reprogram ALL child 
devices again. 
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When the Restore 20-VW2W100-ADV to factory 
setting (clear) operation has been completed, an 
information window pops-up. 
 
Click OK. 

 
 
 
 
 
 
 
 
 
 
Right click on the translator icon. 
 
Contextual pop-up menu appears. 
 
Click on the Program 20-VW2W100-ADV menu 
option. 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
A programming progress window pops-up. 

The Program command can be applied to 

update a translator, to program or update an 
expander. 

Same procedure applies. 
To program an expander right click on the expander 
icon and choose the Program 20-SGWE100-ADV. 
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Programming completion pops-up a confirmation 
window.  
 
OK to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The translator’s product code is now printed out in 
bold. 
 
This means that it has been programmed. 
 
Repeat the restore to factory settings - programming 
procedure for ALL expanders. 
 
Every time you program the translator, a “LOEr” indica-
tion is visualized on the device’s digital display. 
LOEr means: you have programmed the wireless 
configuration on the translator, now you must load the 
devices’ references onto the loop analogue interface. 
 
“LOEr” handling is explained later in the “The load 
procedure”  paragraph. 

 
It does not apply to the 20-SGCWE-ADV central 

node. 
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PROGRAM THE CHILD DEVICES 

 
 
 
 
 
 
 
Connect your computer to the “father” translator or 
expander of the child device you want to link - pro-
gram. 
 
On the System tab page, click on the relevant transla-

tor or expander icon. 
 
Right click over the relevant child device icon. 
 
Contextual menu pops up. 
 
Click on the Program [device code] command. 
 
 
 
 
 
 
 
 
 
 
 
 
A window will pop up, indicating that the translator or 
expander is looking for the device to be linked. 
 
Make sure that the programming switch of the child 
device is switched to “ON”. 

Insert the secondary, then the primary battery into the 
child device. 
The child device’s LED flashes red; this indicates that 
the device is starting up. 
When flashing comes to an end, place the child device 
near the translator or expander and set the program-
ming switch to “1”. 
 
Child device’s linking and programming starts. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Child device’s LED flashes green: linking - program-
ming is complete. 
On WirelEx, a window pops up informing you that the 
device is correctly programmed. 
 
Click OK. 

 
Repeat this procedure for all the other child devices.  
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The programming status of the child device is shown in the Programmed column: 

 
 
 
 
 
 

The wireless system is completely programmed only when: 
 
- all child devices indicate the green programmed check in the Programmed column 
 
- all translator and expander’s product names are written in bold. 
 
The wireless system is not completely programmed when: 
 
- at least a child device indicates a red non programmed X in the Programmed 
 column 
  
- at least one product name of a translator or expander is not written out in bold. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A warning window appears if WirelEx is closed with one or more not programmed devices. 
 
After you have performed any change to the wireless system configuration: 
 
- check the wireless configuration again 
 
- check control panel’s configuration. 
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 = Chid device linked (programmed) 

 = Child device not linked (not programmed) 

If you fail to program completely the wireless 
system: 
 

- the system will not work correctly 
 
- panel could be unable to show faults. 



THE TRANSLATOR TABLE 

 
The child devices configured in a wireless system are organized in a sequential list. 
 
This list is the translator table. It is stored in the translator and updated when the translator is programmed. 
 
In WirelEx you can visualize it in the Translator table window: 

 
 
 
 
 
 
 
in the System tab page, right click on the System icon.  

 
Contextual menu pops up. 
 
Select the Translator table option. 

 
Translator table window appears. 

 
 
 
 
 
 
 

The translator table has 33 lines; each line is indexed in the Position column from 1 to 33. 
The translator is always placed at Position 1. 
Child devices have the Position indexed from 2 to 33. 

Wireless expanders modules are never indicated in the list. 
 
The translator’s front board keypad-display List function uses the Position index to locate the translator and the child devices; check the 20-
VW2W100-ADV manual for better details. 

 
 
When you perform the load procedure (see The load procedure paragraph), starting from the translator table a set of virtual analogue loop 
addresses are generated and stored in the wired analogue loop interface; this address table is then used in the communication process with 
the wired control panel. 
 
The translator and child device’s sequence in the translator table corresponds exactly to the translator and child device’s sequence of ana-
logue addresses in the loop interface. 
 
To make things clearer, suppose you have, for example: 
 
Translator table 
 Translator Position: 1 
 Device #1 Position: 2 
 Device #2 Position: 3 
 Device #3 Position: 4 

 
Translator analogue (start) loop address: 10 
 
Analogue loop address table 
 Translator Analogue address: 10 + (1 - 1) = 10 
 Device #1 Analogue address: 10 + (2 - 1) = 11 
 Device #2 Analogue address: 10 + (3 - 1) = 12 
 Device #3 Analogue address: 10 + (4 - 1) = 13 

 
 
The translator table is viewed in WirelEx with the following data columns: 
 
Position 
The position in the translator table. Values span from 1 to 33. 
 
Expander 

The translator or expander number to which the child device is linked to. 0 is for the translator, expanders values span from 1 to 7. 
 
Device 
Device number. It is translator or expander’s specific. Values range from 1 to 32. 
 
Type 

Indicates the translator’s or child device’s product code. 
 
Comment 
The note that you eventually assigned to the child device. 
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THE TRANSLATOR TABLE - A PRACTICAL EXAMPLE 

 
This is an example of a wireless system configuration - translator table correspondence: 

 
 
 
 
 
 
 
 
 
 
 
Wireless devices linked to the translator. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Translator table window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Wireless devices linked to the expander. 
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THE TRANSLATOR TABLE - HANDLING GAPS 

 
When you delete one or more devices, empty lines, or gaps, remain in the translator table’s list. 
 
You can handle those gaps in two ways: 
 
- add other wireless child devices; empty gaps will be filled up again by the newly added devices; this solution is not always applicable. 
 
- use the Clear table and Fill the table automatically commands. 

 
 
 
 
 
 
 
 
 
 
 
 
Suppose you have, for example, this Translator table. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Right click on the table’s window. 
 
A contextual menu pops up. 
 
Click Clear table. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
All child devices, with the exception of the translator, 
are deleted. 
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Right click on the table’s window. 
 
A contextual menu pops up. 
 
Click Fill the table automatically. 

 
The translator table will not have gaps anymore. 
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UPDATING THE CHILD DEVICES 

 
For the child devices that you have already linked and programmed to the wireless system, you can, if needed, update some, but not all, 
settings. The recommendation is that set in the correct parameters in the first place, before actually linking and programming the child devices; 
nevertheless, in certain circumstances, it could be necessary to perform an update. 
 
List of parameters that can be updated without linking and programming again a child device: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
Right click on the child device’s icon. 
 
Contextual menu pops up. 
 
Click the Properties option. 

 
Modify the required parameter. 
 
Apply to confirm, Cancel to discard the change. 

 
 
 
 
 
 
 
 
 
 
 
If the modified parameter is updatable, the visualized 
icon in the Programmed column for the  
 
specific child device will be: 
 
Right click on the child device’s icon. 
 
Contextual menu pops up. 
 
Click the Update [device code] parameters option. 
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All child devices 

Parent expander’s check-up period 

 
Supervision period 

Optical detectors Sensitivity 

Multi-criteria detectors Sensitivity 

Manual call points Do not supervise Tamper 

Input modules Do not supervise tamper circuit 

Battery output modules Relay Type 

Sounders Do not supervise tamper circuit 

If an is shown instead, the child device 
has to be linked and programmed again. 



 
 
 
 
 
Parameter update can take up some minutes. 
 
 
 
 
 
 
 

 
 
 
 
Update completion pops-up a confirmation window.  
 
OK to continue. 
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ADDITIONAL FUNCTIONS OF THE SYSTEM CONFIGURATION TAB PAGE 

 
The pop up menu, that results from the right click on the wireless devices icons, gives you some additional options: 
 
COMMENTS 

 
 
 
 
You can assign a comment text to each wireless 
device, like its location in the installation site. 
 
 
Right click on the device’s icon. 
 
Contextual menu pops up. 
 
Select Comment. 
 
Comment window pops up. 
 
You can enter up to 31 alphanumeric characters. 
 
Apply to confirm, Cancel to discard the change. 
 
 
 
 
 

DEVICE SUPERVISION 
 
 
 
 
 
 
You can switch on or off the LED indicators of the child 
devices. 
 
 
Right click on the child device’s icon. 
 
Contextual menu pops up. 
 
Select Supervise [device’s product code]. 

 
Select Activate green Led, Activate red Led or Deac-
tivate Leds. 
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On AXIS-ROP, AXIS-ROH and AXIS-RHT the Activate 
green Led option activates the test mode, while the 
Deactivate Leds option deactivates it. 

 
Check these detectors manuals for more data about it. 
 
Remember to deactivate all detector’s LEDs after you have 
carried out all the device’s alarm testing. 



DELETE DEVICE 

 
 
 
 
 
You can delete a wireless device from the configura-
tion. 
 
 
Right click on the device’s icon. 
 
Contextual menu pops up. 
 
Click on the Delete [device’s product code]. 

 
If you delete a child device from an expander, you must 
program the expander AND the translator. 
 
If you delete a child device from the translator, just 
program the translator.  
 
 
 
 
 

MOVE DEVICE 

 
 
 
 
You can move a child device: 
 
- from the translator to an expander 
- from an expander to the translator 
- from an expander to another expander. 
 
 
Right click on the child device’s icon. 
 
Click Move [child device’s product code]. 

 
Click on the destination translator or expander product 
code. 
 
The translator and / or expanders involved in this 
operation must be programmed. 
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SAVING, OPENING AND COLLECTING A SYSTEM 

 
SAVE SYSTEM 

 
 
 
 
 
 
 
When you complete configuring and programming a 
wireless system, it is recommended that you save its 
WirelEx model on file. 

 
 
To do so, click File on the main menu. 
 
File menu options drop down. 
 
Select either Save system or Save system as... 
 
 
 
 
 
 
 
 

OPEN SYSTEM 

 
 
 
 
 
 
 
You can load into WirelEx the wireless system’s config-

uration model. 
 
 
Click File on the main menu. 

 
File menu options drop down. 

 
Select Open system... 
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COLLECT ALL SYSTEM PROPERTIES 

 
 
You can load the wireless system’s configuration model 
onto the WirelEx directly from the translator module. 

 
 
You computer must be connected to the translator via 
the RS232 serial cable. 
 
Right click on the System icon. 

 
Contextual menu pops up. 
 
Click Collect all system properties. 

 
If there are expanders in your system, this operation 
can last up to several minutes. 
 
 
You can click the Collect icon on the WirelEx’s tool bar 

to launch directly this function. 
 
 
 
 

READ THE TRANSLATOR’S OR EXPANDER’S PROPERTIES 

 
 
 
 
 
Similarly to the collect function, you can load either 
from a translator or an expander its specific program-
ming parameters and configuration model (this means 
ALL data, linked child devices types included). 
 
 
You computer must be connected to the translator or 
expander, from which you want to collect its configura-
tion model, via the RS232 serial cable. 
 
Right click on the translator’s or expander’s icon. 
 
A contextual menu pops up. 
 
Click Read [Translator / Expander code] properties. 
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MONITOR THE EVENTS OF THE WIRELESS SYSTEM 

 
HOW TO MONITOR AND EXPORT THE EVENTS 

 
You can perform the monitoring of the events of the wireless system only if all configuration, linking and programming is completed. 

 
 
 
 
Connect the computer to the central node (20-
VW2W100-ADV or 20-SGCWE-ADV) with the RS232 

serial cable.  
 
Click the Events tab. 
 
Events tab page is visualized. 
 
Click the Start icon on the WirelEx’s tool bar. 
 
WirelEx now downloads, from the central node, 
real- time wireless system events. 
 
 
You can also click the Get history icon on the WirelEx’s 
tool bar to download the event history list recorded in 
the central node’s memory. 
 
 
 
 
 
 
 
 
 
 
 
 
The event list can be exported to a file. 
 
 
Click File on the WirelEx main menu. 
 
File menu options drop down. 
 
Select Export events as... 
 
Select HTML. 
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GENERAL EVENTS - CENTRAL AND RELAY NODES 

 
 
 
 
 
 
 

EVENT INDICATION 20-VW2W100-ADV OR 20-SGCWE-ADV 20-SGWE100-ADV 

Translator powered on 
Central node has been powered on or reset. 
All child devices will be reset from alarms and 
faults.  

 

Expander #x powered on  
Expander #x has been powered on or reset. 
All child devices will be reset from alarms 
and faults. 

Main power supply fault  Expander’s main power supply fault. 

Main power supply restored  
Expander’s main power supply restored from 
fault. 

Standby power supply fault  Expander’s secondary power supply fault. 

Standby power supply restored   
Expander’s secondary power supply restored 
from fault. 

No radio link with network device  
No communication with a wireless device 
(expander or child device). 

Radio link with child device normal  
Communication with wireless device 
(expander or child device) has been restored. 

External jamming level: x% 
The channel used by the system is disturbed 
by radio interference. 

The channel used by the system is disturbed 
by radio interference. 

External jamming disappeared 
The radio interference on the channel used 
by the system has disappeared. 

The radio interference on the channel used 
by the system has disappeared. 
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CHILD DEVICE EVENTS 

EVENT 
INDICATION 

20-SG100-ADV 

AXIS-ROP 
20-SG200-ADV 

AXIS-ROH   

20-SG350-ADV 
AXIS-RHT  

20-SGCP100-ADV  20-SGMI200-ADV  

20-SGR(B)S100-ADV 

AXIS-RWSM 
20-SGVA200-ADV 
20-SGBE100-ADV 

20-SGMC200-ADV 
20-SGFI200-S-ADV  

20-SGMCB200-ADV 

Fire alarm Device in alarm. - - 

Device body 
opened 

Device signalled a tamper fault. - 

Device body 
closed 

Device has recovered from a tamper fault. - 

Main battery 
low 

Main battery’s power supply is below the fault threshold. 

Main battery 
normal 

The device has recovered from a main battery’s power supply fault. 

Standby 
battery low 

Secondary battery’s power supply is below the fault threshold. 

Standby 
battery  
normal 

The device has recovered from a secondary battery’s power supply fault. 

General fault 

Optical cham-
ber fault 

- or - 
Optical cham-
ber is dirty 

- or - 
DIP switch  
is on the “ON” 
position. 

DIP switch is 
on the “ON” 

position. 

DIP switch is 
on the “ON” 
position 

- or - 
Always at 
power on (then 
automatically 
recovered). 

DIP switch is 
on the “ON” 
position  

- or - 
Always at 
power on (then 
automatically 
recovered) 

- or - 
Short or open 
circuit on the 
supervised 
input. 

DIP switch is 
on the “ON” 
position 

- or - 
Always at 
power on (then 
automatically 
recovered). 

Always at 
power on (then 
automatically 
recovered) 

- or - 
Short or open 
circuit on the  
supervised 
output. 

Tamper fault 
- or - 

Always at 
power on (then 
automatically 
recovered) 

- or - 
Short or open 
circuit on the  
supervised 
output. 

General fault The device has recovered from the general fault. 

No radio link 
with child 
device 

The child device didn’t communicate with the “father” node for a period of time longer than the supervision time. 

Radio link 
with network 
device normal 

The child device managed to communicate again with the “father” node. 

Child device 
substitution 
attempt 

Two or more child devices, having the same wireless address, are trying to communicate with their “father” node. 

Device 
programmed 

The child device has been correctly linked and programmed. 

Child device 
deleted 

The child device has been removed from the wireless system. 

Output  
enabled 

- The output has been activated. 

Output 
disabled 

The output has been deactivated. - 
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CHECK THE WIRELESS DEVICES’ STATUS 

 
 
 
 
 
 
From the Status tab page you can have the status, 
detection and contamination information on all wireless 
system’s devices. 
 
It is divided into two tables: the left one for central and 
relay nodes, the right one for the child devices. 
 
 
Click the Status tab. 
 
Status tab page comes into view. 
 
Click the Start icon on the WirelEx’s tool bar. 
 
 
 
 
 
 
 

DEVICE 
You have here the device’s icon and product code. 
Status symbols are superimposed on the device’s icons in the lower right region; if more than one applies, the latest detected one is visual-
ized; these status icons are: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ADDRESS 
The wireless address of the device. 
 
SMOKE 

A numeric value proportional to the smoke concentration detected by the child device (applicable only for smoke and multi-criteria detectors). 
 
TEMPERATURE 
A numeric value proportional to the environmental heat detected by the child device (applicable only for temperature and mult i-criteria detec-
tors). 
 
CONTAMINATION 
A numeric value, in percentage units, proportional to the degree of dirt contamination in the optical chamber; spans from 0%, clean, to 100%, 
dirty (applicable only for smoke and multi-criteria detectors). 
 
COMMENT 
A note that you can assign to a specific wireless device (for example an installation location). 

 Device status normal 

 Device in alarm 

 Device in general fault 

 Link fault 

 Device substitution attempt 

 Device tamper fault 

 Primary battery fault 

 Secondary battery fault 

 Unknown status 
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Wireless detector’s data (smoke, temperature and 
contamination) can be viewed in graph format. 
This type of view is in numeric value vs time format. 
 
 
To access this type of view double click on the wireless 
detector’s icon. 
 
To exit this type of view close the window. 
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CHECK THE WIRELESS LINK QUALITY 

 
 
 
 
From the Link quality tab page you can assess the 
wireless link quality of all wireless system’s devices 
(with the exception of the central node). 
 
It is divided into two tables: the left one for central and 
relay nodes, the right one for the child devices. 
 
 
Click the Link quality tab. 
 
Link quality tab page comes into view. 
 
Click the Start icon on the WirelEx’s tool bar. 
 
 
 
 
 

DEVICE 
You have here the device’s icon and product code. 
 
ADDRESS 

The wireless address of the device. 
 
QUALITY (RSSI) 
Wireless link quality with the “father” node in RSSI units. 
 
QUALITY (DB) 

Wireless link quality with the “father” node in dB units. 
 
EVALUATION 
Wireless link quality with the “father” node in “Mark” units; these units are based on an evaluation scale: 

 
 
 
 
 
 
 
 

 
LINKS 

This is the time elapsed from the last communication with the “father” node. 
 
COMMENT 
A note that you can assign to a specific wireless device (an installation location, for example). 
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Mark 2 Unacceptable Very weak: <10 dB 

Mark 3 Becoming marginal Link from 10 to 20 dB; should be >15 dB 

Mark 4 Good Good communication: link from 20 to 30 dB  

Mark 5 Excellent Excellent communication: link > 30dB 



 
 
 
You can visualize the link quality readings of a child 
device in graph format. 
 
 
Click the child device row you are interested in. 
 
The row highlights. 
 
Right click the highlighted row. 
 
Contextual menu pops up. 
 
Click Show device history menu option. 
Note: this option can be shortcut by double clicking the 
row. 
 
 
 
 
The device history window of the selected child device 
pops up. 
 
The window shows the following graphs: 

You can choose whether to have the readings in dB or 
RSSI by selecting the unit type in the drop down 
selection list in the upper left area of the window. 
 
 

These are the other contextual menu’s options you can use: 
 
CLEAR DEVICE HISTORY 
Clears all the Device S / N graph’s values of the child device you have selected. 
 
CLEAR ALL DEVICES HISTORY 
Clears all the Device S / N graph’s values of all child devices in the list. 
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Device S / N 

Child device’s signal / noise ratio vs 
time. 
It is the wireless link quality (Quality 

column in the previous window). 
Can be expressed either in dB or in 
RSSI units. 

Traffic 
Child device channel’s traffic percent-
age vs time. 
It is expressed in percentage units. 

Noise 
Child device channel’s noise vs time. 
Can be expressed either in dBm or in 
RSSI units. 



THE LOAD PROCEDURE  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Use the P1, P2, P3, P4 buttons and the display on the translator’s front board to navigate through the module’s options menu.  
 
1) Press P3 or P4 to scroll up or down until rF is displayed. 
 
2) Press P2. 
 
3) EXP is displayed. 
 
4) Press P2. 
 
5) Press P3 or P4 to scroll up or down until LOAd is displayed. 
 
6) Press P2. 
 
7) ConF is displayed. 
 
8) Press P2. 
 
9) donE is displayed. 
 
10) Press repeatedly P1 until the display is cleared. 
 
 

DISPLAY 

PUSH BUTTON 
(P1) 

PUSH BUTTON 
(P2) 

PUSH BUTTON 
(P3) 

PUSH BUTTON 
(P4) 

The control panel can log the wireless system 
correctly only if the load procedure is done. 
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This procedure does not apply to the  
20-SGCWE-ADV central node. 



GIVE THE TRANSLATOR AN ANALOGUE ADDRESS 

 
After you have completed: 
 
- configuring the wireless system with the WirelEx 

 
- loaded the devices’ references onto the loop analogue interface 
 
you must assign an analogue address to the translator. 
 
1) Press P3 or P4 to scroll up or down until LooP is displayed. 

 
2) Press P2. 

 
3) SA is displayed. 

 
4) Press P2. 

 
5) Use P3 or P4 to increment or decrement the translator’s analogue address: values range from 1 to 240. 

 
6) Press P2. 

 
7) SA is displayed. again. 

 
10) Press repeatedly P1 until the display is cleared. 

 
 
The translator is now addressed with the value you have set. 
 
The wireless child devices too have now an analogue address. 
 
Let’s make an example: the translator has an analogue address of 10. 
Linked to the translator you have three child devices. 
 
You will have: 
 
 Translator  address 10 
 Device # 1 address 11 
 Device # 2 address 12 
 Device # 3 address 13 
 
For more information on the 20-VW2W100-ADV analogue address assignment refer to its user manual. 
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This procedure does not apply to the  
20-SGCWE-ADV central node. 



WIRELESS SYSTEM’S CONFIGURATION SUMMARY 

 
This is just a summary; refer mainly to the specific paragraphs laid out before in this manual. 
 
1) Connect the computer RS232 serial cable to the central node (20-VW2W100-ADV or 20-SGCWE-ADV). 

 
2) Program the central node. 
 
3) Connect the computer RS232 serial cable to an expander (20-SGWE100-ADV). 

 
4) Program the expander.  
 
5) Repeat programming for all 20-SGWE100-ADV’s: go to step 3) until all expanders are programmed. 

 
6) Link - program the child devices to their intended central node and expanders. 
 
7) Load the wireless child device’s references onto the loop analogue interface. 
 
8) Save the configuration WirelEx model in a file: you may need it in the future. 

 
9) Check out that no mistakes were made in the wireless configuration phase (next paragraph). 
 
10) Check out that your wireless system works (next paragraph). 
 
11) If you are using a 20-VW2W100-ADV, assign to it an analogue address. 

 
12) Load the system on the control panel (refer to the control panel’s user manual). 
 
 
CHECK OUT YOUR WIRELESS SYSTEM CONFIGURATION  
 
When you have completed all the wireless system configuration and programming: 
 
1) Check that the 20-VW2W100-ADV (or the 20-SGCWE-ADV) and all 20-SGWE-ADVs are programmed: their name in bold style. 
 
2) Check that you have configured all the wireless child devices (correct device types, correct quantities and correct “father” node). 
 
3) Check that all child devices have been linked - programmed (green check icon in the Programmed column). 
 
4) Check the translator table; in particular check that the child device’s types are correct, they belong to the correct “father” node and 
 they have the correct device number. Obviously check that you have all the child devices in the table. 
 
5) Perform a Collect all system properties. 

 
6) Repeat checks 1), 2), 3), and 4). 
 
7) If you are using a 20-VW2W100-ADV, check that there is no load error (“ LOEr” ). 

 
8) If you are using a 20-VW2W100-ADV, check the child device’s list using the front board keypad-display’s List function. 
 You can have more information on this function from the 20-VW2W100-ADV user’s manual. 
 
CHECK THAT YOUR WIRELESS SYSTEM WORKS 
 
1) Check that the wireless system raises events: try to trigger a tamper fault and alarm a detector or a call point. 
 
2) Check the status of the wireless devices, in normal, alarm and fault statuses. 
 
3) Check the good wireless link quality of the all devices. 
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THE FIRECLONE UTILITY 

 
If you need to replace a 20-VW2W100-ADV, 20-SGCWE-ADV or 20-SGWE-ADV with another one and you want to avoid reconfiguring 
the device with WirelEx, you can use the FireClone utility. 
 
FireClone permits you to copy from the old to the new module the programmed configuration data. 

 
 
 
 
 
 
 
 
 
On WirelEx, click the Tools menu. 
 
On the drop down menu click Fire system clone utility. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
FireClone’s main window appears. 
 
Click Options on the main menu. 
 
On the drop down menu click Settings. 
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Settings dialogue window pops up. 
 
Select the COM port. 
 
Verify Written Data: you can specify whether Fire-
Clone checks the configuration data that was 

transferred to the destination module. 
It is suggested to keep this box checked. 
 
Select the desired Language. 

 
Apply to confirm the changes, Cancel to discard 

them. 
 
 
 
 
 
 
 
 
 
 
Connect your computer to the old central node or 

expander via the RS232 cable. 
Do not use wireless serial interfaces. 
 
Click the left image. 
 
Wait that the configuration is downloaded. 
 
Connect your computer to the new central node or 

expander via the RS232 cable. 
Do not use wireless serial interfaces. 
 
Click the right image. 
 
Wait that the configuration is uploaded. 
 
The configuration has been copied. 
 
 
Note that the configuration is copied temporarily on the 
computer and not saved on its hard drive; if you exit 
FireClone after reading it, this will be deleted. 
 
You must complete the copy operations in one Fire-
Clone session. 
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